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2017/07/01 変光星観測者会議（明治大学 生田キャンパス） 

 

「画像処理・測光フリーソフト”AstroImageJ”（AIJ）の使い方について」～我流入門 

 

東京都 鈴木 仁（日本変光星研究会） 

 

１． AIJ を選んだ理由 

AIP4WINを使おうとしたのですが Windows10に正常にインストールできず（ユー

ザー登録しても何日かして起動すると繰返しユーザー登録を求められる現象）、解決方

法をネットで検索しているうちにAAVSO等のフォーラムでAIJの存在を知りました。

使ってみて次のような点が気に入って常用しています。 

 

・CCDによる 5色（U/B/V/R/I）測光で画像処理、測光処理がしやすい画面。 

 

・軽快に動く。 

 

・マスターフレーム・ダークフレーム作成のために画像の正規化処理、メディアン

コンポジットができる。 

 

・画像の連続再生で測光に不適切な画像（雲通過など）を見つけて測定から外すこ

とが簡単にできる。 

 

・連続測光の時、画像間で星がずれていても星像の重心を探索して測光してくれる。 

 

・重心探索で追いきれない場合には、画像アライメントでの星の位置を揃えること

ができる。 

 

・FWHM を測定して測光アパチャーの設定がワンタッチでできる。また画像ごと

に自動的に FWHMを計測しアパチャー径を変えて測定してくれる。 

 

・スカイアパチャーにほかの星が入っていても自動で除去・計測してくれる。 

 

・画像ごとに測光誤差を算出してくれる。 

 

・測定した星像が飽和していないか表示される。画面でもカーソルでカウント値の

ピークを見ることができる。 
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・無料である。 

 

２． AIJ の入手とインストール 

 

AIJの公式ホームページ 

http://www.astro.louisville.edu/software/astroimagej/ 

にアクセスし、画面サンプルのすぐ下にある「downloading an installation package」をクリ

ックするとダウンロードファイルのあるページに行きます。 

 

AIJは「Java」を使っているのでパソコンに Javaがインストールされていることが

必須です。AIJ の作者は、Windows７以降で 64Bit システムであれば 64Bit 版のイン

ストールを強く推奨しています（32Bit 版だとメモリ不足でうまく動かない時があるら

しい）。32Bit と 64Bit の Java は同じパソコン内で共存できるそうなので、64Bit 版

Windows で 32Bit 版 Javaしかインストールされていない場合は、64Bit Java付きを

インストールすることを推奨しています。 

ここをクリックして 

ファイルのページへ 

http://www.astro.louisville.edu/software/astroimagej/
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 できれば Java 付パッケージをインストールするのが一番簡単です。ダウンロー

ドした ZIPファイルを解凍し、「AstroImageJ」フォルダーを適当なディレクトリにコ

ピーし、フォルダー内の「AstroImageJ.exe」ファイルを起動すれば自動的にセットア

ップが行われて使えるようになります。「AstroImageJ.exe」のショートカットを作っ

ておけば起動が簡単です。 

64Bit Java 付パッケージでインストールをした場合には不要ですが、既に 64Bit 

Java がインストール済みで AIJ のみインストールする場合には、AIJ に 64Bit Java

のある場所のパスを設定する必要があります。少し面倒ですが、英文のインストールマ

ニュアルに従って設定してください。 

 

 

３． AIJ の起動 

 

 土星のショートカットをクリックすると AIJ が起動します。表示されるのは下のよ

うなツールバーだけです。AIJは主に生物研究で使われている画像処理ソフト「ImageJ」

上のアプリケーションとして作られているので、AIJ として使用するのは「File」「Edit」

と①～⑧のボタンだけです。他は本来の ImageJの機能で使いません（と思います）。 

 

         

インストールマニュアル（英文） 

Java無し版 

32Bit Java付パッケージ 

64Bit Java 付パッケージ 

AIJマニュアル(旧版・英文) 

① ②③ ④⑤ ⑥⑦ ⑧ 

②  
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「File」: 画像をスタック（次項４．で後述）に読込み、表示 

「Edit」: スタックメモリーサイズの設定など 

① AstroImageJモードにする（起動すると ONになっている） 

② アパチャー測光の設定 

③ マルチアパチャー測光の設定 

④ オーバーレイ（アパチャーなどが表示されるフレーム）のクリヤー 

⑤ グラフプロット機能の設定 

⑥ 測定結果表の読込み・表示 

⑦ CCD画像処理（Data Processor） 

⑧ Coordinate Converter（分点変換、SIMBADによる対象チェック等）  

私は通常の測光作業では、これらの内、File と⑦DPしか使いません。 

 

４． 最初の設定（後での変更も可能） 

 

AIJは連続測光など、複数枚の連続した画像を一度に読み込んで処理します。これを

「スタック」と呼んでいますが、メモリー上に画像をスタックすれば処理が速くできま

す。このために AIJ はメモリー領域を確保します。確保する上限はパソコンの物理的

メモリー容量の２／３以下を推奨しています。 

「Edit」→「Options」→「Memory & Threads」とクリックすると「Memory」ウィンドウが開

くので[Maximum Memory]の値を設定します。 

 

この例では PC の内蔵メモリーが

4GB(=4000MB)なのでその約 2／3 の

2.6GB(=2600MB)に設定しています。 
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 その他のパラメーター等はよくわからないのでいじっていません。 

 一部の処理を除き、測光や処理がスタック上の画像に対して行われるので元の画像

データが改変されることなく、処理が何回でもやり直せます。 

 もし画像枚数が多くてメモリー上にスタックしきれない場合は、一部をハードディ

スク上に展開する「バーチャルスタック」にします。処理速度は若干遅くなりますが、

多数の画像でも処理できます。これを使うかどうかの設定は、画像読み込み時に随時指

定できるので、やり方は後述します。 

 スタック表示画面ではウィンドウ上部に確保メモリー中の使用割合（％）、バーチャ

ルスタック使用時には「V」の文字が表示されます。 

 

以下、現在の私のデーター処理のやり方に沿って操作を紹介します 

（作業の流れ） 

事前準備 

５．マスターダークフレームの作成 

６．マスターフラットフレームの作成 

 

 

７．観測画像の測光操作 

観測画像（FITS形式、ファイル名にどのバンドで撮ったか判るように U・B・V・R・

I の文字を付加 ← これは CCD カメラのキャプチャーソフトで設定しています）の用

意。 

 

 

（７－１）AIJの「DP」で各バンドごとにダーク減算・フラット補正処理 

 

 

（７－２）一連の処理画像を AIJのスタックに読込み、不良画像のチェック・排除。 

（７－３）画像間の星のズレが大きいときはアライメントで補正する。 

 

 

（７－４）任意の星を選んで FWHMでアパチャー径を決定する。 

 

 

（７－５）マルチアパチャー測光で、目的星、比較星、チェック星を指定して測光。測

光結果を保存して AIJを終了する。 
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 ８．データ整約 

保存した測光結果をエクセルに読み込んで、データ整約を行う。 

・目的星・比較星・チェック星の測光値・誤差値を等級への変換 

・目的星と比較星、比較星とチェック星の等級差の平均値と誤差の計算 

・目的星の機械等級の計算 

・目的星の機械等級を標準システムへ変換 

・VSOLJ報告フォーマットの作成 

・必要に応じて光度グラフを作成 

 

 

５． マスターダークフレームの作成 

マスターダークフレームは観測で使う露出時間ごとに数十枚のダークフレームを撮影し、

メディアンコンポジットして作ります。私の場合、露出時間は 15・30・60・90・120・180・

240・300・360秒、冷却温度は－10℃で各 50 枚撮影しコンポジットしています（時間がか

かるのでカメラに蓋をしてキャプチャ―ソフトで自動撮影しています）。後で処理するとき

にどの露出時間のファイルかわかるようにファイル名の中に”E60_”（露出 60秒）など識別

できる文字を入れて撮影します。 

なるべく煩雑さを避けるため、CCD カメラの冷却温度は一年を通じて一本にできる温度

とし、露出時間には決めた秒数以外は使わない、ビニングは 2×2のみにして、作成したマ

スターダークフレームを使いまわすようにしています。 

元のダーク画像をメディアンコンポジットするのに AIJでは⑦DP（Data Processor）を

使うのですが、ここで問題が起こることがありますので、DPで作成するやり方と DP でう

まくいかなかったときのやり方を説明します。 

  

 (5－1) マスターダークフレームを DP で作成する 

・DPボタンをクリックします。DPウィンドウの前に Coordinate Converter(CC)

ウィンドウが開きますが使わないので CCを閉じます。 

・DPウィンドウ上の[Dark Subtraction]欄の[Build]と[med]だけにチェックを入れま

す。他は外します。 

・欄の中の４つのボックスは、上段が元画像の置かれているフォルダーのパスと元

画像のファイル名、下段がコンポジットした画像（マスターダークフレーム）を

保存するフォルダーのパスとコンポジット画像のファイル名を指定します。 

  各ボックスの脇にあるフォルダー／ファイルマークをクリックするとフォル

ダーやファイルの選択ウィンドウが開くので、そこで当該フォルダーやファイ

ルを選択すれば指定することができます。 
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  ここで AIJ の特長は、複数枚の画像をまとめて処理するのにファイル名のワ

イルドカード（「*」等）を使ってファイルの中から任意のグループだけを指定で

きることです。 

  画像処理や測光作業でワイルドカードが使えますので、あらかじめファイル

名にどのような識別文字を入れるか使いやすいように考えておいてください。 

  処理する画像と処理した画像の保存フォルダー・ファイル名の指定が終わっ

たら画面の一番下にある[START]ボタンをクリックします。メディアンコンポジ

ットされた画像ファイルが出来上がるはずです・・・・しかし、原因は不明です

が、元の画像ファイルに問題はないのにうまくマスターファイルが作成できな

いことがあります。トラブルの現象としては、 

  

 （1）出来上がったファイルが AIJ で読み込めない、FITS ファイルとして認識

しない（自分で生成したくせに何を？と腹が立ちますが）。 

  画像を読み込もうとすると下の図のようなメッセージが出て、読み込んでく

れない上、ステライメージやマカリィなど他のソフトを使っても開くことがで

きません。もちろん元の画像は正常に開けますし、FITSヘッダーも特に問題あ

るようには見えません。 

  同様に処理してうまくいくファイルもあるので、今のところは原因がわかり

ません。 

ここだけチェック 

合成した画像の保存フォルダー 

元になる画像の保存フォルダー 

元画像ファイル名 

ワイルドカード ”*” で露出

0.05 秒の画像 50 枚が選

択されている。 

合成画像のファイル名を指定 

選択・指定が終わったらスタート 
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（2）明らかに異常なマスターフレームが生成される。AIJで正常に読み込め開く

ことができるが、元の画像から見て明らかに異常な画像です。これも特定の画像で

発生しますが原因は不明です。 

以下は①50枚コンポジットのための元画像 1枚、②DPで 50枚のメディアンコ

ンポジットをした時に作成された異常なマスターダーク、そして③後述する手順

で作成した正常なマスターダークです。 

さらにその下は、④正常なマスターダークを使って作成したマスターフラット

（後述）と⑤異常なマスターダークを使って作成したマスターフラットです。この

ままでは使用できません。 

 

① コンポジット前のダークフレーム元画像 
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② DPでメディアンコンポジットした時に作成された異常マスターダーク 

 

 

③ （５－１）の手順で作成した正常なマスターダーク 
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④ ②の異常なマスターダークで作成した異常なマスターフラットの例 

 

 

⑤ ③の正常なマスターダークで作成した正常なマスターフラットの例 

 

  

  以上のように、DPで作成したマスターダークが読込み不能であったり、異常なも

のが作成される場合は、残念ながら、別の画像処理ソフトで作るか、次の手順で作成

してください。 
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  （５－２） スタックに読込んで[Process]を使って作成する方法 

メディアンコンポジットしようとする画像ファイルを AIJ のスタックに読込ん

で、スタックウィンドウのメニューの中にあるコンポジット機能を使ってメディ

アンコンポジットします。出来た画像は自動保存されないのでスタックウィンド

ウを閉じる前に必ず FITS形式で保存操作をします。 

DPで作成した場合には FITSヘッダーには合成までの処理履歴が記録されます

が、この方法で作成した画像ファイルのヘッダーには元の撮影データーや処理履

歴が失われてしまうのが欠点です。 

 

メニューバーから [File] →  [Import] →  [Image Sequence]で 「 Open Image 

Sequence」ウィンドウが開くので、コンポジットする元画像のフォルダーを開き、

画像ファイル名をどれでもいいですからダブルクリックします。 
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「Sequence Option」ウィンドウが開きます。ここではダブルクリックしたファ

イルを含むフォルダー内の全ファイルを読み込もうとしていますから、[File name 

contains:]にコンポジットしたいファイルを識別する文字を入力します（例えば露

出 15秒のファイル名の中に”E15－”という文字列を設定してあれば「E15－_」と

入力します。）該当するファイルの個数:nnn がウィンドウの下の「xxxx×yyyy×

nnn」に表示されるので正しく選択できたか確認できます（xxxx,yyyy は画像の縦

横のピクセル数です）。下の例では、撮影したダークフレームを収めたフォルダー

内の全ファイル数が 459 個、その中から「E15」という文字を付けた露出時間 15

秒のファイルを指定し、50個が該当していることを示しています。 

また、ここに「４．最初の設定」で触れたバーチャルスタックの設定チェックボッ

クス[Use virtual stack]があります。チェックを入れればバーチャルスタックが有効

になります。読み込む枚数や画面の画素数が大きく、メモリー内にスタックできな

い時はエラーメッセージが出るので、その時はバーチャルスタックにします。 

ちなみに、AIJではスタック上の一枚一枚の画像を「スライス」と呼んでいます。 

読込みたいファイルの 1 つをダブルク

リック。又は選んで「開く」をクリック。 
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[OK]をクリックすると指定したファイルがスタックに読込まれ、スタックのウィン

ドウが開きます。[Process]→[Combine stack slices into single image]をクリック。 

 

459 ファイル中、「E15」という文字

列を含むファイル名のファイルは、

５０個ある。 

バーチャルスタックの設定 
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「ZProjection」ウィンドウが開くので[Median]を選んで[OK]をクリックするとメ

ディアンコンポジットが始まります。 

 

コンポジットが終わると、コンポジット画像のウィンドウが開きます。この画像

がマスターダークフレーム（この例では冷却温度－10℃、露出時間 15秒のマスタ

ーダーク）です。メニュー[File]→[Save image/slice as FITS]で適当なファイル名を

付けて保存します。保存せずにウィンドウを閉じると消えてしまいます。また、保

存は必ず FITS で行って下さい。（もしウィンドウを閉じてしまった場合は、まだ

スタックウィンドウが残っているので[Process]からやり直すことはできます。） 

 

閉じる前に保存を忘れない。 

形式は必ず「FITS」で。 
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６． マスターフラットフレームの作成 

 マスターフラットのためのフラット画像の撮影はいろいろな方法がありますが、私はま

だ明るいうちに筒先に拡散板（乳白アクリル板）を付け、空に向けて撮影しています。 

別途、フラット撮影の露出時間と同じ時間のダーク画像も撮影し、前項５．のやり方でマ

スターダークを作成しておきます。このフラット画像とマスターダークを使ってマスター

フラットフレームを作成しますが、前項と同じく「DP」で作成する方法と、それがうまく

いかない場合の方法について説明します。 

  

 （６－１）マスターフラットフレームを DP で作成する 

  「DP」を開きます。 

「Dark Subtraction」欄の[Enable]をチェックし、フラット用のマスターダークを指

定（保存してあるフォルダーとファイル名）する。 

「Flat Division」欄の[Build]と[med]をチェックし、上段に元になるフラット画像の

フォルダーとファイル名（複数枚なのでワイルドカードで）を指定する。下段に作

成したマスターフラットを保存するフォルダーとファイル名を指定する。 

[Remove Gradient]（オプション）はフラット光源に偏りがあるなどの原因でフラ

ット画像のレベルに傾きがある場合にチェックすると傾きを補正します。光学系

の光軸ズレによる偏りの場合には使わない方がいいと思います。 

[START]ボタンをクリックするとマスターフラットが作成・保存されます。 

 

「DP」では、各フラット画像→マスターダーク減算→傾き補正（オプション）→

正規化処理→メディアンコンポジット→マスターフラット、の流れで自動的に作

成が行われます。 

予め作成しておいたフラット

用のマスターダークのフォ

ルダーとファイル名 

元になるフラット

画像のフォルダ

ーとファイル名 

作成したマスターフ

ラットを保存するフ

ォルダーとファイル

名 

複数の画像はワイ

ルドカードで指定 

Remove Gradient

はオプション 
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（６－２）スタックウィンドウを使ってマスターフラットを作成する 

 もし、マスターダーク作成の時のように「DP」での作成がうまくいかない場合

には、「DP」とスタックウィンドウを使って作成します。 

 作業のアウトラインは以下の通りです。また、前項（６－１）と同じくフラット

用のマスターダークは作成してあるものとします。 

 

（１）「DP」のダーク減算機能でフラット画像からマスターダークを引く。 

    （これは通常の観測画像を処理するときに使う機能です） 

（２）ダーク減算したフラット画像をスタックに読込む。 

（３）[Process]の[Normalize image/stack]で正規化する。 

 （薄明フラットなど明るさに変化があるときに必要です） 

（４）[Combine stack slices into single image]でメディアンコンポジッ

トして出来上がったマスターフラットを FITS 形式で保存する。 

  

 （１）「DP」でダーク減算する 

  「DP」を開きます。 

一番上にある「Science Image Processing」「Filename Pattern Matching」の[Enable]を

チェックし、フラット画像のフォルダーとファイル名を指定。ファイルは複数枚あ

るのでワイルドカードで指定します。 

「Dark Subtraction」は[Enable]のみチェックし、用意してあるフラット用マスター

ダークのフォルダーとファイル名を指定します。 

「Save Calibrated Images」欄の[Enable],[32]をチェックし、ダーク減算したファイ

ルの保管フォルダ名を指定します。このフォルダは自動的に元のフラットファイ

ルのあるフォルダーの中にサブフォルダーとして作成されます。 

[Suffix]はデフォルトで”_out”が入っています。サブフォルダーに出力されたファ

イルの名前にはこの文字が付加されます。変えても構いません。 

[Format]は特に指定しなくても FITS形式で保存されます。 

最後に一番下の[START]ボタンをクリックします。 

ダーク減算処理が始まり、処理された画像が次々に表示されます。 
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 （２）ダーク減算したフラット画像をスタックに読込む 

  （５－２）で説明したので説明略 

 

 （３）画像を正規化処理する 

スタックウィンドウ上の[Process]→[Normalize image/stack]でウィンドウが開く

ので[Median]を指定して[OK]でスタート。（下のチェックボックスと数字の効果は

未確認。そのままにしてます。） 

 

フラット画像のフォルダーとファイル名 

マスターダークのフォルダーとファイル名 

ダーク減算したファイルを保管

するサブフォルダ（自動生成） 
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しばらくすると正規化処理が終わるので、スタックウィンドウの下にあるスク

ロールで画像（スライス）をチェックすると各画像のカウント値がほぼ揃っている

のが確認できます。 

 

（４）メディアンコンポジットを行う 

そのままの画面で[Process]→[Combine stack slices into single image] でメディア

ンコンポジットをすればマスターフラットの出来上がりです。やりかたは（５－２）

で説明したので省略します。 

 

７． 観測画像の測光操作 

以上までのマスターダーク／フラット作成でやってきたように、AIJではダーク減算・フ

ラット補正などの画像処理は主として「DP」で、これから説明する測光などの処理はスタ

ックウィンドウで行います。 

 

（７－１）DPを使って観測画像をダーク減算・フラット補正処理を行う 

     DPを開きます。 

「Science Image Processing」「Filename Pattern Matching」の[Enable]をチェックし、

観測画像のあるフォルダーとファイル名を指定。 

「Dark Subtraction」の[Enable]をチェックし、マスターダークのフォルダーとファ

イル名を指定。 

「Flat Division」の[Enable]をチェックし、マスターフラットのフォルダーとファイ

ル名を指定。 

「Save Calibrated Images」の[Enable]と[32]（32ビットで保存）をチェックし、補正

処理した画像の保存サブフォルダを指定。 

[START]ボタンをクリックして処理を開始します。 

処理が終わったら、画像ウィンドウ、ログファイルウィンドウを閉じます。 
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 （７－２）補正済の画像をスタックに読込む 

[File] → [Import] → [Image Sequence]で補正済の画像をスタックに読み込みま

す。もし画像が１枚だけ又は特定の画像のみ開きたい場合は、[File] → [Open]で読

み込みます。 

下の方にあるスライダーを動かすとスタック上の画像（スライス）を確認できる

ので、雲などで測光に不適当な画像があれば、ツールバーの左端にある削除ボタン

でスタックから削除します。スタックからは削除されますが元のフォルダー内の

ファイルには影響ありません。 

後の測光時に測光アパチャーは、星像の重心位置を自動探索してくれますが、も

しスライス間の星像位置が大きく飛んでいる場合には探索しきれません。その場

合には次項（７－３）の方法でスライスの位置補正をおこなって星像の移動を許容

範囲に揃えます。 

問題がない場合には（７－４）に進んでください。 

 ※（表示される画像が裏返しになっている場合） 

撮影したカメラによって CCDピクセルの座標原点の取り方が違うためか、読み

込んで表示された画像が反転（鏡像）している場合があります。その場合は画面上

のメニューバーから[View]→[Invert X],[Invert Y]のいずれかを選んで反転させます。

画像を反転させると N,E を示す矢印が合わなくなるので、[WCS]→[Set north and 

east arrow orientations for images without WCS]で正しい方位にセットしてください。

これらの設定は自動的に記憶され、以降 AIJ を立ち上げた時も有効になります。 
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 （７－３）画像（スライス）の位置補正をする（星像の飛びが大きい場合） 

  [Process]→[Align 

stack using WCS or 

apertures]でアライメ

ント（位置補正） 

機能を使います。 

 

 

 

 

 

スライダーを動かすとスライスを確認できる。 

再生ボタンを押すと連

続でスライスが表示さ

れる 

スライス削除ボタン 
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「Stack Aligner」ウィンドウが開きます

ので、アライメントの基準になる星を指定

するアパチャーのサイズ（ピクセル半径）

を入れます。星像位置の飛ぶ範囲をカバー

できる大きさにします。 

 大きすぎると隣の星を捉えてうまくア

ライメントできません。 

 基準星の選び方とアパチャー径の兼ね

合いを試してください。 

[Align only to whole pixels]と[Show help 

panel during aperture selection]以外のチ

ェックはすべて外します。 

[OK]をクリックすると操作ヘルプが表示

され、画像上でアライメントの基準星を選

択できるようになります。周囲に星がなく全スライスを通じてはっきり写ってい

る星を選びます。カーソルを星に合わせて左クリックするとアパチャーが表示さ

れて選択されます。取り消しは合わせてもう一度左クリックすると消えます。 

 今のところ AIJ のアライメントには回転ズレ補正の機能がありませんが、測光

のためにはアパチャーが重心探索できる範囲にズレが収まっていればいいので問

題ありません。 

 基準星は複数指定することができますが、同上の理由で１個で問題ありません。 

  基準星の指定が終わったら画像上で右クリックするとアライメントが始まります。 

 

左クリックで基準星を指定 
右クリックでアライ

メント開始 

操作ヘルプ 
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バーチャルスタックを使っている場合

は自動的に「aligned」という名前のサブ

フォルダーが作成され、アライメントさ

れた画像が”aligned_”を付けたファイル

名で保存されるので、一度ウィンドウを

閉じてそのファイルを読み込みます。 

 バーチャルスタック

を使っていない場合は

画像は保存されず、ス

タック画面にそのまま

アライメントされた画

像が表示されています。 

 スライダーを動かし

てスライス上の星像が

あまり動かなければア

ライメントは成功です。 

 失敗した場合には元

のファイルを再度読み

込んでアパチャー設定

を変えてやり直します。 

 

 

 



 

p. 23 
 

 （７－４）測光アパチャー径を決める 

スタック画像上の任意の星を[Alt]キーを押しながら左クリックする、または、任

意の星を左クリックしてから[Analyze]→[Plot seeing profile]で星像のプロファイル

グラフが表示されます。 

 

こ こで星の アパチャ ー

（SOURCE）とスカイのア

パチャー（BACKGROUND）

が自動的に表示されますの

で、[Save Aperture]ボタンを

クリックすると、測光アパチ

ャー径がこの値に設定され

ます。 

もちろん後の測光メニュー

で任意に設定することもで

きます。 

 

 

 

 

 

 

AIJのデフォルトでは星のアパチャー半径を FWHM（半値全幅）の 1.4倍に設

定するようになっています（この値も測光メニューで変更可）。すなわちアパチャ

ー半径は HWHM（半値半幅）の 1.4×2=2.8倍に設定されることになっています。 

上のグラフの例では HWHM=2.49なのでアパチャー半径は約 7.0に設定される

はずですが 12.0 となっています。小さすぎるよりは良いと思うのですが、どうし



 

p. 24 
 

てこうした設定になるのかは不明です。とりあえず問題なく使ってはいます。 

 

 （７－５）マルチアパチャー測光（比較星 1個、チェック星 1個の差測光） 

AIJでは複数の目的星（Target：Tn）と比較星（Comparison: Cn）を設定して、

複数の同時測光、アンサンブル測光ができますが、今のところ比較星、チェック星

各 1個で基本的な差測光をしています。 

まず測光メニューの設定をしておきます。この設定は自動的に記憶されるので

次回 AIJを立ち上げた時にも有効となり毎回設定する必要はありません。 

 

ツールバーのマルチアパチャー測光ボタン  をクリックすると設定メニュー

が開きます。メニューは３面ありそれぞれ設定項目があります。 

 

（設定メニュー①） 

 

 

(7-4)で設定したアパ

チャー径。修正可 

使わない 

自動で使わない 

重心探索 

見失ったら自動を中断 

スカイから星を除去 

画像の FWHM に

応じてアパチャ

ー径を変える 

操作ヘルプを表示 

測光時に比較星の

等級を入力する。

結果は等級表示 ☑すると使わないグラフプロットウィンドウが開いて邪魔 

測定するスライス 

設定メニュー②へ 
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 （設定メニュー②） 

理由はわかりませんが、メニュー①と重複している項目が多いです（上半分）。 

CCDの項目は使用カメラの実測値を元に設定します。 

 

 

 （設定メニュー③） 

  結果ファイルに出力する項目、測光画面に表示する情報等を指定します。 

 

 

無暗に削除しない 
画像の測光誤

差算出に必要 

CCD 飽和、直線性

警告のレベル設定 

設定メニュー③へ 

ここを☑すると前にセットしたアパチャーが表示

されなくなる。（セットはされるが表示されない） 

メニュー① へ戻る 

アパチャーに表示される

項目を指定 
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設定が終ったらメニュー①に戻りメニュー下にある[Place Apertures]ボ

タンをクリックすると測光アパチャーの設定が始まります。 

最初に目的星を左クリックすると緑色のアパチャーT1 がセットされ、

次に比較星をクリックすると赤色のアパチャーC2がセットされます。比

較星というカテゴリーがないので[Shift]キーを押しながら左クリックし

て緑色のアパチャーT3を比較星としてセットします。 

間違えた時はそのアパチャーをもう一度クリックすれば消去できます。 

 

  指定を終わったら右クリックで測光がスタートします。 
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測光が終ったら測光結果のファイル「Measurements.xls」を忘れずに

保存します。保存が終ったら AIJを終了します。 

 

 

８． エクセルで測光データの整約をおこなう 

 保存した「Measurements.xls」をエクセルシートに読込み、必要なデータを使って整約、

報告書式の作成、グラフの作成等を行います。Measurements.xls の項目を以下のように利

用しています。 

整約項目 
Masurements.xls 

算出に必要な項目 
算出方法 

対象名、測

光バンド 

Label（ファイル名） 文字列関数で抽出 

撮影日時 JD_UTC（露出中央値） JD_UTC － 2415018.5 = UTCのシリアル値 

露出時間 EXPTIME そのまま（秒） 

冷却温度 CCD－TEMP そのまま（℃） 

使用アパチ

ャ ー サ イ

ズ、FWHM

係数 

Source_Rad(base) 

Sky_Rad(min) 

Sky_Rad(max) 

FWHM_Mult 

そのまま：星半径（ピクセル） 

そのまま：スカイ内半径（ピクセル） 

そのまま：スカイ外半径（ピクセル） 

そのまま：（倍） 

目的星 ,比

較星 ,チェ

ック星の等

級値 MN 

Source－Sky_T1 

Source－Sky_C2 

Source－Sky_T2 

 

MN = －2.5＊log(Source－Sky_N) 

ここで N = T1,C2,T2 
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差測光での

測 光 誤 差

（等級値） 

Source－Sky_T1 

Source_Error_T1 

Source－Sky_C2 

Source_Error_C2 

2.5＊log( 1 + 

Source_Error_T1^2   Source_Error_C2^2 

Source－Sky_T1^2    Source－Sky_C2^2 

 

９． さらに便利な機能、有用な機能（と思うもの） 

以上説明してきたことは、基本的な使い方だと思います。AIJにはもっと高度な機能

が備わっているので皆さんの研究をお願いしたいと思います。 

 

・Plate Solve 機能 → 赤経、赤緯、方位、エアマス値等の取得。SIMBAD等データ

べースとの連携。（Astrometry.net にアクセスして API キーを入手すれば無料で使え

ます。設定もほとんど不要で簡単） 

・バイアスフレームの使用による画像補正操作の簡素化・自動化。 

・複数個の比較星を使ったアンサンブル測光 

・複数の目的星の同時測光。エアマス値を使って広写野での測光（大気補正）。 

・CCDの非直線性補正機能 

・グラフプロット 

・リアルタイムで画像処理・測光・グラフプロットし変光をモニター。 

 

以上いろいろと私見で書いてきましたが、思い違いや無知な点もあると思いますの

でご指摘を頂ければ幸いです。 

 

１０． 参考資料 

“AstroImageJ 2.4.1 User Guide plus Getting Started with Differential Photometry” 

http://www.astro.louisville.edu/software/astroimagej/guide/AstroImageJ_User_Gui

de.pdf 

・古いバージョンに基づいた手引きですが使い方が丁寧に説明されています。 

“ASTROIMAGEJ: IMAGE PROCESSING AND PHOTOMETRIC EXTRACTION FOR ULTRA-

PRECISE ASTRONOMICAL LIGHT CURVES”    by Karen A.Collins 他 

http://iopscience.iop.org/article/10.3847/1538-3881/153/2/77 

・AIJを紹介する新しい論文。AIJの中での処理や誤差の算出についても触れられ

ています。 

  [User Forum for AstroImageJ] 

    http://astroimagej.1065399.n5.nabble.com/ 

 ・AIJのユーザーフォーラムです。使い方、問題解決など参考になります。 

+ ) 

http://www.astro.louisville.edu/software/astroimagej/guide/AstroImageJ_User_Guide.pdf
http://www.astro.louisville.edu/software/astroimagej/guide/AstroImageJ_User_Guide.pdf
http://iopscience.iop.org/article/10.3847/1538-3881/153/2/77
http://astroimagej.1065399.n5.nabble.com/
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星見屋のご案内
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0. ZWO社
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 上海空港から新幹線で約40分 蘇州市の若者しかいないビジネス街にオフィス
 社長はSam Wenさん
 元々エンジニア
 天文ファン
 デスクの上は試作品でいっぱい
 小さな会社だけど伸び盛り
 社員はみんな若い
 社内のクリーンルームで組み立て



I. ZWO社のCMOSカメラ
1. 現行カメラの比較(特性･用途別)
型番 ASI071

MC
ASI1600
MM/MC

ASI174
MM/MC

ASI178
MM/MC

ASI185
MC

ASI224
MC

ASI290
MM/MC

センサーサイズ APS-C 4/3インチ 1/1.2インチ1/1.8インチ1/1.9インチ 1/3インチ 1/2.8インチ
ピクセルサイズ 4.8μm 3.8μm 5.86μm 2.4μm 3.75μm 3.75μm 2.9μm
ADC 14Bit 12Bit 12Bit 14Bit 12Bit 12Bit 12Bit
特徴 高DR 低発熱 高DR 低発熱 グローバル

シャッター 裏面照射 フルHD 裏面照射

センサー IMX071 MN34230 IMX174LLJ/
IMX174LQJ IMX178LQJ IMX185LQJ IMX224LQRIMX290LQR

センサー発表時期
(Sony) N/A N/A 2013/12 2013/08 2013/08 2014/10 2015/02
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I. ZWO社のCMOSカメラ
1. 現行カメラの比較(特性･用途別)
型番 ASI071

MC
ASI1600
MM/MC

ASI174
MM/MC

ASI178
MM/MC

ASI185
MC

ASI224
MC

ASI290
MM/MC

太陽 ○ ○ ◎ ○ ○ ○ ○
月 ◎ ◎ ○ ◎ ○ ◎（強拡大) ◎（強拡大)

惑星 ○ ○ ○ ○ ○ ◎ ◎
(大口径有利)

DSO ◎ ◎ ○ ◎ ○ ○ ○
スカイモニター ○ ○ ◎ ◎ ○ ○ ○

・大型センサー
・高DR

・大型センサー
・高DR

・大型センサー
・グローバル
シャッター

・高感度
・微細ピクセル

・14Bit
・電子ファイン

ダー ・高感度 ・高感度
・微細ピクセル

◎：最適 ○：適 星見屋見解
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I. ZWO社のCMOSカメラ
2. ZWO製カメラに搭載しているセンサーと
旧コダック製センサー の比較
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センサー KAF8300 KAF1603ME ASI1600 ASI071(IMX071) ASI094

サイズ 4/3" 4/3" APS-C Full Size

縦 x 横 (mm) 17.3 x 13.0 13.8 x 9.2 17.3 x 13.0 23.6×15.6 36x24

ピクセル数 3326 x 2504 1536 x 1026 4656 x 3520 4928×3264 7376x4928

ピクセルサイズ 5.4μm 9 μm 3.8μm 4.78μm 4.88μm

FPS 0.5FPS N/A 23FPS 10FPS 5FPS

Full Well キャパシティー 25ke 100ke 20ke 46ke 53ke

リードノイズ 8e 15e 1.2e - 3.6e 2.3e-3.3e 2.1e-3.1e

ダイナミックレンジ(DR) 70db 74db 75db 82.8db 84db

DR のBit表示 11.6bit 12.3bit 12.5bit 13.8bit 14bit

ADC 16Bit 16Bit 12Bit 14Bit 14Bit

Dark Current (-10C) 0.01e/s N/A 0.01e/s N/A 0.005e/s



I. ZWO社のCMOSカメラ
2. ZWO製カメラに搭載しているセンサーと
旧コダック製センサー の比較
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センサー KAF8300 KAF1603ME ASI1600 ASI071(IMX071) ASI094

サイズ 4/3" 4/3" APS-C Full Size

縦 x 横 (mm) 17.3 x 13.0 13.8 x 9.2 17.3 x 13.0 23.6×15.6 36x24

ピクセル数 3326 x 2504 1536 x 1026 4656 x 3520 4928×3264 7376x4928

ピクセルサイズ 5.4μm 9 μm 3.8μm 4.78μm 4.88μm

FPS 0.5FPS N/A 23FPS 10FPS 5FPS

Full Well キャパシティー 25ke 100ke 20ke 46ke 53ke

リードノイズ 8e 15e 1.2e - 3.6e 2.3e-3.3e 2.1e-3.1e

ダイナミックレンジ(DR) 70db 74db 75db 82.8db 84db

DR のBit表示 11.6bit 12.3bit 12.5bit 13.8bit 14bit

ADC 16Bit 16Bit 12Bit 14Bit 14Bit

Dark Current (-10C) 0.01e/s N/A 0.01e/s N/A 0.005e/s

ダイナミックレンジが狭いと
ADC(Analog-Digital変換)が

高性能でも
撮像できる輝度範囲は

狭い



NICOLAS DUPONT-BLOCH 氏の
FACEBOOKでの報告
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10

ラス･アルゲティ(ヘラクレス座α星)のスペクトル
Star Analyzer 100, Celestron 5, ASI071MC-cool
. センサーの撮影できる帯域が広く､一般のカラーセンサーでは映らない近赤外にも感度がある｡
･Hαやメタンおよび近赤外線撮影適しているといえる｡



 ZWO社マニュアルより

I. ZWO社のCMOSカメラ
4. システムチャート
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星見屋からのご提案

I. ZWO社のCMOSカメラ
4. システムチャート

2016/10/23                                                                         ©M2M Inc. 星見屋
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Pentax DA Lens

Nikon Lens

PK-M4/3アダプター
絞り付

EF-M4/3アダプター
絞り付

NIKON-M4/3アダプター
絞り付

絞り付アダプター等､市販品で適用可能なものを
集めたページはこちら

http://hoshimiya.com/?mode=f16


ディーラーシリアル№付与
星見屋発送のカメラは1個づつフラット撮影で保護ガラスとセンサー
の傷、汚れチェック､汚れのある場合はクリーニングもしくは保護ガ
ラス交換

 St-4ポート付のカメラは赤道儀に接続して動作確認→ケーブルの断線
確認

 USBハブ付のカメラはそれぞれのポートにASI120、MiniEFWを接続し
て動作確認→ケーブルの断線とポートの接触確認

冷却カメラは冷却設定温度到達までフラット撮影､冷却中の結露着霜
のないことを確認

冷却中は温度変化とダーク撮影で冷却能力と冷却の効果を確認

I. ZWO社のCMOSカメラ
5. 星見屋のASIカメラ出荷前チェック
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フラットテスト コリメーターにFC76､FlatGenerator160使用
ASI1600,071はF40(5倍バーロー),それ以外はF80(5倍×2倍バーロー)

ASI290MCのNG例
(但し､最近は
ほとんど汚れて
いない)

I. ZWO社のCMOSカメラ
5. 星見屋のASIカメラ出荷前チェック
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フラットテスト コリメーターにFC76､FlatGenerator160使用
ASI1600はF40(5倍バーロー),それ以外はF80(5倍×2倍バーロー)

ASI290MCのNG例

I. ZWO社のCMOSカメラ
6.星見屋のASIカメラ出荷前チェック
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 Moravianから無償で提供されている統合管理ソフト
 冷却カメラの制御
 ガイドカメラによるオートガイド､ガイドカメラ無しでの誤差検出式オートガイド
 ASCOM機器制御(赤道儀､フィルターホイール､フォーカサー､ドーム等)

 画像処理
 位置測定
 光度測定
 観測者向け

I I.各種ソフトウェア
2.天体撮影用ソフトウェア：SIPS
(Scientific Image Processing System)

2016/10/23                                                                         ©M2M Inc. 星見屋
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 ブルガリアのIvaylo Stoynov氏作成のソフト
 ほとんどの機能が無料
 バルーンヘルプ日本語化済
 他ソフト､サービスとの連携やインターフェースを備えるのが特徴

 Cartes Du Ciel (プラネタリウムソフトと同期､画角表示)

 PHD2 (オートガイド､ティザリング)

 PlateSolver2､AllSkyPlateSoler (位置解析による導入補正､AllSkyPlateSolverは日本語化済)

 DSO Browser (観測地における撮影対象の見ごろ予告メーリングリスト→撮影対象リスト､撮影計画作成)

 撮影のための機能は全て保有

I I.各種ソフトウェア
3.天体撮影用ソフトウェア：APTおよび

連動するソフトウェア群

2016/10/23                                                                         ©M2M Inc. 星見屋
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VSOLJが見つけたoEA候補 

2017年7月1-2日 
VSOLJ 永井和男 

@明治大学 生田キャンパス 



oEAの発見 

• RZ Casは部分食のEA型食連星 
 
 
 
 
 

• 東京理科大 天文部森田さんの(1972年)眼視観測を見ると 



oEAの発見 

• RZ Casは部分食のEA型食連星 
 
 
 
 
 

• 東京理科大 天文部森田さんの(1972年)眼視観測を見ると 

 
部分食なのに皆既食になる時がある 

 



RZ Casの怪奇？ 



RZ Casの怪奇？ 

RZ Casの主星は超短周期のたて座δ型脈動変光星だった 
 
その変光と食による変光が重なって皆既食になる時がある 



oEAの光度曲線 

FR Ori 

PG 1336-018 

RR Lep 

BO Her 



脈動変光星 

• 脈動星 

• 星が膨張収縮していま
す 

 



HR図と変光星 

• 変光星を知るにはHR図が欠かせません 
• 変光星はHR図上の各所に分布していますが変光星の種類ごとに固まって分布しています 
• 脈動星も同様にそれぞれの位置に分布しています。 



HR図と脈動変光星 

ミラ型変光星 

RED Edge 

対流層 

放射層 

Blue Edge 



第一電離ヘリウムは温度によって透明・不透明に変化
する 

電離ヘリウムと脈動変光 

温度高：不透明 

温度低：透明 

RED Edge 
Blue Edge 

温度 

明
る
さ

 

HR図上を左から右に移動すると言う事は温度が下が
ると言う事 

BEより下がると放射層のどこかにヘリウムの第一電離
状態の層が出来る 

Κメカニズム（カッパ機構）がはたらいて変光する 



RE・BEのその先に 

ケフェイド不安定帯は主系列と重なっている 

RED Edge 
Blue Edge 

温度 

明
る
さ

 

主系列 

ZAMS 

TAMS 

HR図 

食連星のおよそ半分がSD型で 
主星がA-Fのものが多い 

 
 

よって、oEA候補も多い 



• たて座δ型変光星（δ Sct）とは（GCVSより） 
 
– 銀河ディスク（星形成領域） 
– 種族Ⅰ 
– A0～F5 主系列あたり 
– 変光周期 0.01～0.2日 

• 14分～4.8時間 
– 変光範囲 0.003～0.9（V）等級 

• 数ミリ等級が多い 
– 脈動は多重周期で変光が無くなる時もある 

ここにいると変光星になるなら不思議では無い？ 



oEAの特徴 

• 2016年11月で約200例が発見されている 
• DもSDも公転周期と脈動周期に関係が有る 

– 公転周期が13日を超えると関係は無い 
– 潮汐力が脈動に影響を与えている 

• これに質量移動が加わる 
• ZAMS近くは脈動周期が短い 



oEA発見の推移 

• 最初のoEAは日本の研究によって発見された 
• 以降の発見は全てが海外のもの 
• 日本のアマチュアの測光データベースのVSOLJ-Obs

（日本変光星観測者連盟）や Vsnet-Eclを調べるとoEA
を思われる観測が有る 
– これらがoEAであると言う論文は無い 



事例1：AG Leo (Shiokawa, 2017)  



事例1：AG Leo (Shiokawa, 2017)  



事例2：V343 Lac (Kasai,2016)  



事例2：V343 Lac (Kasai,2016)  



まだまだoEAは隠れています 

• VSOLJ-OBSは宝の山 
• まだまだ未発表のoEAがあります 
• この先の新たな観測からもoEAは発見できる
事でしょう！ 

• VSOJ-obs databaseからoEAを探して、まとめる
作業が必要 



Astro Image J を使った天体測光 

2017年7月1-2日 
変光星観測者会議 2017 

VSOLJ 永井 和男 
@明治大学 生田キャンパス 



差測光か / 標準星測光か 

アパチャ・フォトメトリ 測光 連続測光 

差測光 比較星１つで測光 連続して撮影した画像
を一度に差測光 

標準星測光 複数の比較星を使って
測光 

連続して撮影した画像
を一度に標準星測光 

デジタルカメラはRAWで撮影して標準星測光する事が望ましい. 
比較星の測光バンドとの相関がハッキリしている場合は差測光
でも良い. 



サンプルにしているField 



Astromety.netの利用 

赤丸の印をクリックすると 
Astrometry設定ウインドウが現れて 
STARTボタンを押すとWCSの取得が始まり
ます 
※USER KEYが必要 



Astrometry.net User Key 取得 
• 何かのアカウントでサインイン 
• My Profileを選ぶと 
• Keyがもらえます 



以降（の測定）はRA,RDが付いてます 
WCSが取得されます 
 
 

測光するとRA,RDが得られます 



写っている変光星を測光する 
WCSを取得してから 
どれが変光星か調べず 
とにかく星をクリックする 
 
 
この例では221星をクリックした 
RA,RDの付いた, Souce-Skyが
取得された 



Tycho2とマッチングさせる 

Tycho2から比較星カタログをつくる → このカタログと測定値の相関式をつくる 
・2分以内に接近した星を削除 
・GCVSに載っている星(変光星)を削除 
・8等級より明るく4等級より暗い星を選別 

カタログと測定値の相関式 
cG bandだがV等級と一致している 



GCVSとマッチングさせる 

測定した星の中にGCVSの変光星があれば 
ソフトが自動測光する 
 
 
 

結果をKWSと比較した 
こちらもよく一致している 



Astro Image J ：まとめ 

• Source-Sky_T1 , Source-Sky_C2・・Cn 
– 等級を計算するツールが必要 

• 連続測光ができる 
– 複数の比較星を指定できる 

• Astrometry.netが利用できる 
– 今回作成したソフトで写っている数多くの変光星
を測定できた 

– マニアルを作成したら公開を予定しています 
– 連続測光も出来ないか検討して行く 



周期が分からない食変光星の観測 

2017年7月1-2日 
VSOLJ 永井和男 

@明治大学 生田キャンパス 



自動測光観測 
• 2010年から10cm反射望遠鏡に冷却CCD（Mutoh CV-04）を付けてGCVSに周期の

記述がない食変光星の自動測光観測を行っています。 
• 2017年2月に望遠鏡を15cmに交換しました。この期に合わせて今までの測光

データの解析を行いました。 

2017～ 2012～ 2010～ 

10cm F6 
CV-04 
Ic band 
Advanced GT mount 

10cm F6 
CV-04 
Ic band 
Vixen SP mount 

15cm F4 
SBIG ST-402 
B, V, Ic band 
Vixen SP mount 



• 赤緯 +5ﾟ から -25ﾟ までの 18星 を観測（実際には激変星も含めて23星） 
• 観測中の星が南中したら次の東側の星に望遠鏡を向ける 
• 西側の観測対象星が近いと観測時間が少ない 
• 南中した時点で次の星は昇っている必要がある（星選定の条件） 

自動観測対象の星 



観測星はGCVSに周期の記述が無い 

• AAVSO VSXに周期の記述がある物がある 
• VSXでは変光タイプが違うものもある 

No Object RA RD Type VSX Period(VSX) Obs.Period Obs.Num.

1 CX Cet 0130.5 -1734.0 E: CST UN 2010/07/18-2016/12/23 1355

2 DG Cet 0150.6 -0457.3 E CST UN 2012/08/24-2016/12/23 449

3 DS Cet 0216.2 -2100.5 EA: CST UN 2012/08/12-2016/12/23 631

4 V1125 Tau 0339.0 +0047.8 E E UN 2012/08/26-2016/12/23 1222

5 HH Eri 0427.5 -1706.5 EA CST UN 2012/09/10-2016/12/29 879

6 NSV03262 0654.1 +0411.1 EA: EA UN 2012/11/12-2017/01/13 2231

7 NY Hya 0921.4 -0640.3 EA EA 4.774075 2015/10/31-2017/02/15 2064

8 NSV05015 1054.8 +0550.9 E: E: UN 2014/12/26-2016/12/23 467

9 TX Crv 1200.8 -1209.5 E: CST UN 2010/02/18-2017/02/25 1926

10 HY Vir 1308.5 -0240.7 EA EA 2.7323377 2010/05/03-2017/03/03 2534

11 IL Lib 1509.0 -1147.5 E EA 5.76937 2012/06/06-2017/02/25 2422

12 NSV09725 1749.5 -0747.1 EW: EW: UN 2013/03/28-2016/05/18 631

13 QS Ser 1819.8 -0457.7 EA: CST UN 2010/04/13-2016/06/10 580

14 V4088 Sgr 1851.1 -2018.0 E E UN 2012/06/03-2016/05/04 396

15 NSV12207 1937.7 -1627.2 E: E: UN 2012/07/29-2016/07/30 504

16 NSV13173 2036.9 -1554.6 EW: EW: UN 2012/07/29-2016/09/27 87

17 BM Cap 2048.9 -2037.1 E: CST UN 2012/06/03-2016/09/27 145

18 NSV14470 2315.7 -2431.2 E: CST UN 2012/07/23-2016/09/09 292



PDM解析（VSXに周期あり） 

• NY Hya 
• 4.773862日 
• 4.774075 VSX 

 
 

• HY Vir 
• 2.732349日 
• 2.7323377 VSX 

 

 

• IL Lib 
• 5.769344日 
• 5.76937 VSX 



PDM解析（周期性なし） 
Object GCVS type VSX type Remarks 

DG Cet E CST たぶんCST 

DS Cet EA: CST CST 

NSV03262 EA: EA 周期性が見当たらない 

TX Crv E: CST CST 

NSV09725 EW: EW: もし周期があるなら1.36日付
近だがKWSを解析しても周期
性なし 

QS Ser EA: CST データが精度なし 

NSV12207 E: E: 変光が検出されていない 

NSV13173 EW: EW: データが精度なし 

BM Cap E: CST たぶんCST 

• VSXでCSTはCSTと思われる 
• VSXで「食」は追加確認が必要か 



PDM解析（不明瞭な周期性） 
• V1125 Tau 
• E(VSX) 11.273957日 

 
 
 

• HH Eri 
• CST(VSX) 19.788918日 
 

 
 
• NSV05015 
• E(VSX) 12.552408日 



PDM解析（不明瞭な周期性） 
• V4088 Sgr 
• E(VSX) 32.417413日 

 
 

 
• NSV14470 
• CST(VSX) 2.417405日 

 
 

 
• CX Cet 
• CST(VSX) 0.664782日 

– 周期性有り 
– EWと思われる 
– KWSからも同じ周期 



PDM解析サマリー 

• VSXに周期があるものは同じ周期が検出された 
• 観測数・精度が不十分でVSXでも「食」となっているものもあるが、この観測では変光していないと思われる 
• CX CetはEW型の食変光星で周期が0.66日 

No Object Type VSX Period(VSX) PDM 精度 備考

1 CX Cet E: CST UN 0.664782 〇 周期性あり

2 DG Cet E CST UN たぶんCST

3 DS Cet EA: CST UN CST

4 V1125 Tau E E UN 11.273957 × かなり怪しい、継続観測が必要

5 HH Eri EA CST UN 19.788918 × ゆっくりとした変光か？

6 NSV03262 EA: EA UN 周期性が見当たらない

7 NY Hya EA EA 4.774075 4.773862 〇 VSXと同じ

8 NSV05015 E: E: UN 12.552408 × 短周期ではなさそう 

9 TX Crv E: CST UN CST

10 HY Vir EA EA 2.7323377 2.732349 〇 VSXと同じ

11 IL Lib E EA 5.76937 5.769344 〇 VSXと同じ

12 NSV09725 EW: EW: UN 1.364267 × もし周期があるなら、この当たりか？KWSも周期性なし

13 QS Ser EA: CST UN データが精度なし

14 V4088 Sgr E E UN 32.417413 × 32～33位か？ハッキリしない

15 NSV12207 E: E: UN 変光が検出されていない

16 NSV13173 EW: EW: UN データが精度なし

17 BM Cap E: CST UN たぶんCST

18 NSV14470 E: CST UN 2.417405 × 暗い値があるがRealか分からない



結果 

• CX Cetは周期性を検出できた 
• VSXでCSTは変光していないと思

われる 
• VSXも食と記述されているものは

可能ならば継続観測が望ましい 

No Object RA RD Type VSX Period(VSX) 備考

1 CX Cet 0130.5 -1734.0 E: CST UN 周期性あり

2 V1125 Tau 0339.0 +0047.8 E E UN 観測精度不足

3 NSV03262 0654.1 +0411.1 EA: EA UN 周期性が見当たらない

4 NSV05015 1054.8 +0550.9 E: E: UN 短周期ではなさそう 

5 NSV09725 1749.5 -0747.1 EW: EW: UN KWSも周期性なし

6 V4088 Sgr 1851.1 -2018.0 E E UN ハッキリしない

7 NSV12207 1937.7 -1627.2 E: E: UN 変光が検出されていない

8 NSV13173 2036.9 -1554.6 EW: EW: UN 観測精度不足

2010年の観測風景 



最近の観測・測定方法と観測結果

伊藤芳春

概要

特に最新の観測方法というものではないが，観測対象と処理方法を報告する。また，使用頻度の

少ない冷却 CCDカメラを星空モニター用に使用し始めた。この画像の中にも変光星が写っており

脈動変光星を測定したので紹介する。撮影は自動化し簡単であるが，変光星の写っている画像を探

し測定するのは根気のいる仕事であった。食変光星 V347 Draと脈動変光星 SS Virの観測結果を

報告する。

1 食変光星の選定

観測対象は，Mt.Suhora Astronomical Ob-

servatory の web サイトの Eclipsing Binaries

Linear ephemerides から星座ごとの食変光星

のリスト*1を参考に比較的観測回数の少ない

食変光星を選び観測している。2017 年春の観

測対象には V347 Draを選んだ。V347 Draの

データは表１の通りである。　

表 1 V347 Dra

赤経 16ｈ 08m33s

赤緯 63° 18’39”

食変光星の型 EA/RS

等級 12.4mag（AAVSO ERROR)

周期 0.507280日（12時間 10分）

スペクトル型 ‐

2 観測方法

観測には，35cm シュミットカセグレン望

遠鏡に冷却 CCD カメラ SBIG STF8300 を

取り付け観測している。望遠鏡の導入には

*1 http://www.as.up.krakow.pl/ephem/DRA.HTM

TheSkyX Pro と Tpoint を使い導入精度を上

げている。撮影には，MaximDL 6 を使用し

ている。以前は CCDSoft を使用していたが，

Windows のバージョンアップに対応しなく

なったため MaximDL 6 を使用することとし

た。望遠鏡と CCD カメラから USB 延長ケー

ブル（25m）で室内に導き，XPパソコンで自

動観測している。観測準備に約 30 分かかり，

自動観測後は仮眠を取り, 子午線通過時間に起

き望遠鏡を反転させ明け方まで自動観測をして

いる。

3 画像の測定

多色測光しているため，観測データのフォル

ダーには各フィルターで撮影した画像が混在し

ている。図 1 のコマンドプロンプトでフィル

ター毎に分類している。MS-DOS 時代にはよ

く使ったが，今更コマンドプロンプトでもない

と思いながらもマウスで範囲指定してコピーし

たり，混在したまま測定した後フィルター毎に

並び替えて削除するよりは早い。ワイルドカー

ドを使い 1 行打ち込むだけでフォルダー内の

fits 画像が全てコピーできるので便利である。

撮影画像のファイル名は次のようになってお

1



図 1 コマンドプロンプト

り，ハイフンの前の文字は自分で指定でき，以

降はMaximDL 6が自動的に割り付けている。

v347dra170611-001B.fit　

B はフィルター名で，他のフィルターは

V,Rc,Ic となる。コマンドプロンプトで画像

ファイルを振り分けるコマンドは次の通りであ

る。

cd：フォルダーを移動する

mkdir ｂ：新規にｂという名前のフォルダーを

作る

copy *b.fit ｂ：B フィルターの画像を全てｂ

フォルダーにコピーする

この後，フィルター毎にフラット, ダーク処理

をし AIP4Winで測定する。

4 Excelで計算

コンピューターでの計算は，その発展とと

もに Basic，QuickBasic，Delphi(Pascal)で行

ってきたが，DOS や Windows のバージョン

アップのたびに購入しなければならなかった。

Excelはどこのコンピュータにでもインストー

ルされているので最近は Excel で処理してい

る。日心補正，位相計算も組んである。実は大

気減光補正計算も組んでいるが変光星と比較

星の大気の厚さの差はほとんどないので等級差

に影響はない。以前は，マクロを組むとウイル

図 2 V347 Dra CCD画像

図 3 V347 Dra 変光星図

スチェックにかかったため使用していなかった

が，マクロは簡単なので計算式のコピーに利用

している。

5 V347 Dra

V347 Draは EA/RS型の食変光星であるこ

とがわかっている。回転変光星の RS型のうち

食変光が見られる型であり，食外で正弦曲線

のような光度変化があり，その原因が成分星の

黒点活動によるものである。図 2 に CCD 画

像，図 3に AAVSOの変光星図*2を示す。比較

星は，GSC4192:2364，チェック星は UCAC3

307:103935 を使用した。図４の光度曲線を見

ると主極小がないことがわかる。これは，主極

*2 http://www.aavso.org/apps/vsp/
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図 4 V347 Dra光度曲線

小と副極小を間違った単純なミスと思われる。

5月 28日に極小を捉えたが，その日にウイルス

対策ソフトを入れ直したためコンピューターが

観測途中でフリーズしてしまい極小のきれいな

光度曲線が描けなかった。副極小も微小な減光

があるようである。図４の等級が 2段になって

いるのは 2 色をグラフに描いたものではなく，

6 月 19 日の観測から比較星とチェック星を入

れ替えたものである。無造作に比較星・チェッ

ク星を選び測定していたが，ある時等級差に気

づき入れ替えたものである。明るい星を比較星

とした方が測光精度が上がっており，小さな副

極小もとらえられている。

6 星空モニター

測光観測をしていると雲が気になる。CCD

カメラのデータ転送がパラレルポートのためあ

まり使わなくなった機材の有効活用である。観

測用の天体望遠鏡は，撮影ソフトの向上により

撮影フィルター回転の自動化とオートガイダー

により長時間の追尾が可能となり，仮眠が取れ

るようになったが，その間の空の状態が知りた

くて夜空を撮影するカメラを製作した。手持ち

の接続リングで視野は狭いが標準レンズが接続

できピントも合った (図 5）。視野は 10°，天

図 5 標準レンズを付けた星空モニターカメラ

図 6 箱の中から星空をモニター

頂に向けたいが常時固定して撮影するため雨や

雪が降ってもカメラが濡れないよう子午線方向

で天の赤道に向ようにした。木の箱に入れ視野

が覗けるだけの窓を開けている (図 6)。

表 2 星空モニターカメラ

冷却 CCD SBIG ST-9　

レンズ タクマー 50mm

フィルター V

視野 10°

撮像ソフト　 CCDSoft

露出　 10秒

露出間隔　 10分

3



6.1 観測可能な変光星

観測可能な変光星の赤緯は +5°～ -5°，明

るさは 7等級までという条件で GCVSから選

んだ (表３)。カメラを固定しているため子午線

通過付近でしか観測できない。視野 10°で撮

影するため目標天体を 3コマ撮影できるように

10分毎に露出し，露出時間は天体の移動とバッ

クのカブリを考慮に入れ 10 秒とした。これま

で IN Hya,MW Ser,SS Vir,SW Vir,U Ophを

測定している。各変光星の子午線通過時刻は

Excelで日付を入力すると表示できるようにし

ているが，画像を選び出し測定するのは意外と

根気のいる仕事である。

表 3 観測可能な変光星

変光星名 赤経 赤緯

1 CK Ori 5:30:20 4°

2 V Mon 6:22:44 -2°

3 V0932 Mon 7:10:35 -1°

4 IN Hya 9:20:37 0°

5 SS Vir 12:25:14 0°

6 SW Vir 13:14:04 -2°

7 MW Ser 15:28:43 3°

8 U Oph 17:16:32 1°

9 V1362 Aql 18:48:42 -2°

10 V1363 Aql 18:51:26 -1°

11 V1364 Aql 18:52:01 -1°

12 V1365 Aql 18:52:22 0°

13 TT Aql 19:08:14 1°

14 V1294 Aql 19:33:37 3°

15 η Aql 19:52:28 1°

6.2 SS Virの測定など

SS Vir の 観 測 を 2017 年 1 月 16

日 か ら 17 夜 行 っ た 。比 較 の た め

KWS(Kamogata/Kiso/Kyoto Wide-Field

Survey) のデータとグラフにした（図 7）。ほ

図 7 SS Virの光度曲線

ぼ一致しているが，精度が良いのは 7等級まで

である。あまり多くは望めない。一連の測定

中，変光星図にはない天体があった。撮影画像

には明るさの変化はなくすべての画像に写って

いる。画質が良くないながらもやや輪郭がぼけ

ていた。一般の星図で確認すると球状星団M5

であった。

表 4 SS Vir

変光星の型 SRA

等級 6.0-9.6V mag

周期 36.1日

スペクトル型 C6,3e(Ne)

7 まとめ

変光星図をみてほぼ同じに見えたので比較

星を適当に使っていたが，明るい星を比較星に

使ったところ副極小が見えてきた。明るい星を

比較星に使いましょう。コマンドプロンプトも

意外と便利で，矢印↑キーで前に打ち込んだコ

マンドを順々に呼び出すことができ，これも便

利である。観測には以前のように付きっ切りで

観測する必要がなくなり，仮眠の時間が取れる

ようになったが，春から夏にかけて夜の時間が

短くなると仮眠時間が取れなくなり体調不良に

なった。健康第一であるので十分注意したい。

4


	永井
	VSOLJが見つけたoEA候補
	oEAの発見
	oEAの発見
	RZ Casの怪奇？
	RZ Casの怪奇？
	oEAの光度曲線
	脈動変光星
	HR図と変光星
	HR図と脈動変光星
	電離ヘリウムと脈動変光
	RE・BEのその先に
	ここにいると変光星になるなら不思議では無い？
	oEAの特徴
	oEA発見の推移
	事例1：AG Leo (Shiokawa, 2017) 
	事例1：AG Leo (Shiokawa, 2017) 
	事例2：V343 Lac (Kasai,2016) 
	事例2：V343 Lac (Kasai,2016) 
	まだまだoEAは隠れています

	永井
	Astro Image J を使った天体測光
	差測光か　/　標準星測光か
	サンプルにしているField
	Astromety.netの利用
	Astrometry.net User Key 取得
	以降（の測定）はRA,RDが付いてます
	写っている変光星を測光する
	Tycho2とマッチングさせる
	GCVSとマッチングさせる
	Astro Image J ：まとめ

	永井
	周期が分からない食変光星の観測
	自動測光観測
	自動観測対象の星
	観測星はGCVSに周期の記述が無い
	PDM解析（VSXに周期あり）
	PDM解析（周期性なし）
	PDM解析（不明瞭な周期性）
	PDM解析（不明瞭な周期性）
	PDM解析サマリー
	結果

	ADP8E5C.tmp
	M2M INC. 星見屋�「ZWO社CMOSカメラのご紹介」
	自己紹介
	星見屋のご案内
	目次
	0. ZWO社�
	I. ZWO社のCMOSカメラ�1. 現行カメラの比較(特性･用途別)
	I. ZWO社のCMOSカメラ�1. 現行カメラの比較(特性･用途別)
	I. ZWO社のCMOSカメラ�2. ZWO製カメラに搭載しているセンサーと�　旧コダック製センサー の比較�
	I. ZWO社のCMOSカメラ�2. ZWO製カメラに搭載しているセンサーと�　旧コダック製センサー の比較�
	NICOLAS DUPONT-BLOCH 氏のFaceBookでの報告
	I. ZWO社のCMOSカメラ�4. システムチャート
	I. ZWO社のCMOSカメラ�4. システムチャート
	I. ZWO社のCMOSカメラ�5. 星見屋のASIカメラ出荷前チェック
	I. ZWO社のCMOSカメラ�5. 星見屋のASIカメラ出荷前チェック
	I. ZWO社のCMOSカメラ�6.星見屋のASIカメラ出荷前チェック
	I I.各種ソフトウェア�2.天体撮影用ソフトウェア：SIPS�(Scientific Image Processing System)
	I I.各種ソフトウェア�3.天体撮影用ソフトウェア：APTおよび�　　　　　　　　　　　　　　　　　　　　　　　　　　連動するソフトウェア群




